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The Excel Workbook Window:  

Spreadsheets are programs designed to allow handling of data with relative ease.  

Calculations ranging from simple addition to the most complex are automatically handled by 

the use of formulae.  

Similar to the Word processing layout except that the editing area is divided into separate 

vertical columns (A, B, C, etc.) and horizontal rows (1, 2, 3, etc.)  Where each separate 

column intersects with each individual row we are presented with an individual cell, which 

can be readily referenced individually.  The cell highlighted in the picture is therefore: Cell 

A1.  

The “Current Cell” is displayed in the name box at the top left of the screen.  

 

You may select a cell by either   

• Pointing to it and left clicking in it with the mouse.    

• Using the cursor arrow keys (left of the numeric keypad).  

  

Entering Data: Data to be entered may be of 

various types e.g.:  

• Text or Numeric or as a formula.  

  

Calculations can only be performed on Numeric data and if a cell included in a calculation 

contains text, the following error message may result: #VALUE!  

  

Navigation between cells:   
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Enter the following numbers in the cells shown.   

EXERCISE:   

 

 

 

 

AutoSum feature:  

  

Highlight the cell “A5”.  

  

Select the “AutoSum” tool from  

the top right of screen  

  

 

The following formula will automatically display =SUM(A1:A4) while cells “A1” to “A4” are 

surrounded by a highlighted border.  

Press the “Return” key to accept this formula.  

This highlights cell “A6” and displays the sum of the       

contents of cells “A1” to “A4” within cell “A5”.  

  

If the value of any of the included cells is subsequently  

changed, the value in cell “A5” will change automatically.  

  

EXERCISE:   

Formatting Cells:  

If we require cells to display the € sign, we must format the 

cell to automatically insert such characters, or the calculations 

cannot be automatically processed.  

Click into cell A5  

Right click on the highlighted cell to display the                                 

“Mouse dropdown” menu and select “Format cells”  



Spreadsheets   

  

  3  

 

While the cell displays “€149.00”, it should be noted that the formula bar above the main 

editing screen displays the actual formula in use (in this case, the sum of the cell range A1 to A4) 

Fill in numbers in cells “B1” to “D4” inclusive.  

  

Copying Cell contents – copying formulae:  

Having filled in appropriate figures as outlined above it is possible to simply copy the formula 

from cell “A5” across a range of cells in the same row, as follows.  

 Highlight cell “A5”.  

 Move the cursor to the bottom 

right corner of cell “A5” until the 

cursor changes to a black cross.  

 With the left mouse button held 

down, drag the mouse cursor 

across to include cells “B5, C5 and 

D5”. 

 Release the mouse button to see the sum for each column displayed.  

From the “ Number ” tab,    

select “ Currency ”, “ two decimal places ” and  “ € ”  

symbol,  then click “ OK ”   

It will be found that the format of cell “A5” now  

changes to include the Euro sign and two decimal  

places.   

  

  Drag   
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Select cell E1 and use “AutoSum” to add the contents of the cell range A1:D1. 

Format the cell to include the € sign and two decimal places. Press the Return 

key.  

Highlight cell E1 and move the cursor to the bottom right corner until it 

changes to a black cross.  

With the left mouse button held down, drag the mouse cursor down to include 

cells E2, E3 and E4  

Release the mouse button to see the sum for each row displayed.  

  

Renaming a worksheet  

At the bottom left of the screen, a tab ‘Sheet1’ is displayed.    

  

Right click on “Sheet 1” to display a pop-up menu.  Click  

“Rename” and type in your course code.  

   

  

Inserting a new column  

  

Highlight column “A” by right-clicking in its heading.  

Select “Insert” from the drop-down menu. This inserts a  

column to the left.  

Inserting a new Row  

Highlight row “1” by right clicking on “1”. Select “Insert” from the drop-down menu. This 

inserts a row above.  

Merging Cells  

When entering text such as a heading to span across a page, it is often helpful to “Merge” 

the cells together, across the top row.  For this, the “Merge and Centre” tool is used.   

 

 

 

  
Enter the text “Title”, in the merged cells.  

Highlight cells “A1” to “G1” and select the  

“Merge and Centre” tool.   

If it is necessary  to unmerge   cells then  

simply re - click the “Merge and Centre” tool  
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Shading Cells  

Highlight the cells previously merged by simply clicking into it.   

Right click on the highlighted cells and select “Format  

Cells”.  

Select the “Fill” tab.  

Choose a light colour and click OK.  

  

If necessary, to deselect shading, with the cells  

highlighted as before, select “No colour”.   
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Charts  

Click the plus tab at the bottom of 

the page to open a new sheet.   

Rename the new sheet ‘Bar Chart’  

Enter the following data in the 

same cells as indicated:   

  

To generate a chart from tabular data, highlight all of the data cell range, including applicable 

Column and Row Headings.  

 

Click Recommended Charts.  

 

  

  

Note how all data is automatically inserted including “X-axis”, “Y-Axis” and “Legend”  
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From the “ Insert ” tab, go to  

the Charts grouping,    

  

  

  

  

  

Click ‘All Charts’    

  

and select ‘3 - D Cluster Column’   
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You can change the title of the graph, and adjust many aspects of the graph through the edit tools 

that appear on the graph  

Exercise: add more data to the table as follows -  

In cell E1 type in ‘Washers; cell E2 type 220; cell E3 type 60.  

Click onto the graph so the CHART TOOLS tab with subheadings Design and Format appears.   

  

 

In the  Data   grouping, click  Select   Data   
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Spreadsheets   

 

 

 

 

 

If we change the Chart data range the software will pick up the additional cells. Change the capital 

letter D to E and click OK. You should see the new adjusted graph.   

Exercise: add additional data to the graph as 

follows -   

• Cell A4: 25mm 

• Cell B4: 45   

• Cell C4: 70  

• Cell D4:90  

• Cell E4: 80  

 

  

The information in the Chart data range is as follows - =Bar Charts!$A$1:$E$3  

  

Change the number “3” at the end to the number “4” and your table should incorporate the new 

data.   

  

 ACTION: Save your work as your Surname Forename Excel 1 

 

 

  

  

  

  

  

  

  

  

  

This information is the Chart data range ='Bar Charts'!$A$1:$D$3 
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Adding a Watermark to a Worksheet  

A watermark is faded text or a logo in paper. It may be visible or only visible when the paper 

is held up to the light. A Watermarks on the pages of a file may indicate that the content of 

the file is confidential or that it is incomplete (i.e. a draft) and requires more work.  

Excel does not include a true Watermark feature, but an image file can be inserted into a 

header or footer to approximate a visible watermark.  

Since the information in headers and footers is normally displayed on every page of a 

workbook this method of inserting a watermark will ensure that it appears on all pages.  

 

Exercise:  

Creating and Saving a Watermark  

Open MS Word  -  From the Design tab select the down arrow on the Watermark button. 

Selecting one of the watermark options inserts it into the page.   

 

 

 

 

 

 

 

 

 

 

Select any one of the watermark options and it will appear in your document.  

  

  

Go to the Search function   

  

and type in ‘Snip’ and you 

will see the snipping tool app appear. Or press Shift, Windows 

and S to activate the snip tool. 

    

  

  

  

  

 

 

Snip the area around the watermark and when done save it  

as a jpeg file on your computer.  

How to save your snip as an image: paste your snip into your 

word document, then left click to select the image, resize the 

image to fill the full A4 page, right click and choose ”save 

as picture”. Name the file, choose the location and save 

type before you click save. 

  
  

  
  
  



 

10 

 

Now go back and open up your Excel 1 file, click plus to insert a new spreadsheet and 

name it Watermark.    

  

 

In Excel from the "Insert" tab go to the Text grouping and select "Header & Footer"   

  

 

  

  

Selecting the "Header & Footer" Button displays the "Design" tab  

  

 
  

Locate and Insert the jpeg file (watermark) created earlier.  

  

  

The watermark is not immediately visible but a 

code - &[Picture] - appears in the header box 

of the worksheet.  

  

  

  

  

Click on any cell to leave the header area and the watermark appears on the worksheet  

    

  

  

Note:   

When you have added the watermark, Excel is in "Page Layout View".  

  

  

To return to "Normal View" simply click the  

"Normal" Button at the bottom right of the screen   

  

  
  
  
Select the Picture Button   
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Wrap Text  

When you type text that is too long to fit in the cell, the 

text overlaps the next cell. If you do not want it to 

overlap the next cell, you can wrap the text.  

  

 Move to cell A1.   

1. Type Text too long to fit.   

2. Press Enter.   

3. Return to cell A1.  

  

  

4. Select the Home tab / Alignment 

group  

5. Click the Wrap Text button.   

  

  

Excel wraps the text in the cell.   
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Exercise: 

Recap on Charts – do this as a revision/reminder exercise!  

Open a new spreadsheet 

through the tabs at the 

bottom of your workbook 

Excel 1 and fill in the cell 

data shown here. Rename 

the spreadsheet tab “Bricks”.  

   

1. Select all of the cell data, click the “Insert” tab  

  

“Recommended Charts” then select “All 

charts” then select “3-D Clustered 

Column”   

    

 

 

This automatically inserts the chart   

   

   

Format the chart  

 

editing.  

Change the title of the chart to “Bricks”  

  

  

2.   From the “Charts” grouping click  

  

There are shortcut buttons to the side of your chart that can be used for  

Use these buttons to  move the legend to the right-hand side of your  

chart.   
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Switch Row/Column  

Right click on the Chart   

  

  

  

  

  

  

  

  

  

  

  

    

 

 

Your chart should look like this now       

  

Click “ Select Data ”    

Select “Switch Row/Column” Button   

The   Rows and Columns are reversed   
displaying the information differently     

ACTION: Save your work as your 

Surname Forename Excel 1 
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Exercise:   

Embedding a chart and/or table from MS Excel into MS Word dynamically  

While MS Word has built-in functionality for generating both Tables and Charts, often it 

is more appropriate to handle large amounts of data from within a spreadsheet package 

and subsequently generate a chart within a word-processor document to link 

dynamically to the spreadsheet data.  

1. Open a new workbook and populate it with 

the following information: Rename 

the spreadsheet tab “Embedded 

Chart”.   

 

• Column headings  

• Row headings  

• Numeric data  

 

  

  

Clustered column Chart by normal means  

“Copy”  

  

  

4. Open a new MS-Word document, name it 

“charts 1” and save it.  

  

Object” and “Paste Link”   

 

 

  Mon  Tue  Wed  Thur  

Week 1  33  90  12  98  

Week 2  22  30  23  76  

Week 3  44  78  34  65  

Week 4  55  67  45  54  

2.   Within the spreadsheet, generate a 3-D 

  

3.   Right click on the chart border and select  

5.   From the   Home tab  select the   down - arrow under  

Paste   then select    “Paste Special”   

  

  

6.   Select   “Microsoft Office Excel Chart  

      
This inserts a dynamically linked copy of  
the chart from MS - Excel into MS - Word   
Any changes made to  the original data  
within MS - Excel will be   automatically  
updated within MS - Word!     

0 
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Now go back to the Excel workbook and change the numbers in cells D2, D3 and D4 to 

98  

Check if the WORD document has updated, if the data doesn’t update in MS Word, just 

click the graph as if you were selecting it (in older versions of WORD you can right click 

on the embedded chart and select “Update Link”)  

  

If that does not work, then do the 

following:  

  

In MS WORD right click on your table 

to see the options in the picture to the 

right.  

  

Select the option which reads “Keep  

Source Formatting and Link Data (F)”  

  

  

If this is not available, you can always 

delete the image and reinsert it!  

  

 

Dynamic Table insertion   
The same process may be used to dynamically insert a Table of Data from Excel into 

Word:  

• Within MS-Excel, highlight the table of data   

• Right click on the highlighted table and select Copy  

• Open the MS-Word document  

• From the Home tab select the down 

arrow under Paste then select     

Paste Special  

• Select Microsoft Office Excel 

Worksheet Object and Paste Link   

  

Double-clicking on the embedded table in MS-Word will automatically reopen the 

associated spreadsheet  

 

 

  Mon  Tue  Wed  Thur  

Week 1  33  90  12  98  

Week 2  22  30  23  76  

Week 3  44  78  34  65  

Week 4  55  67  45  54  
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Exercise: 

Display or hide zero cell values  

Open a new spreadsheet, rename the tab Hide 0  

Fill in the cell data opposite using the correct 

Sum function to calculate Net Value all the way 

down to row 20.  

  

When we place a formula in a cell the value 

displayed is the result of the formula calculation.  

When the cells referenced by the formula 

contain no data, the result can display as either 

a zero value or a blank cell.  

By default, zero values are displayed as  

0's (zeros).  In the example, cell “D18” contains the formula, “=A18*C18” and 

consequently displays “0.00” as its default value.  Since this is a template for an invoice, 

it is preferable that these cells simply display blank until a value is calculated by means 

of appropriate data entry.  

It is possible to change options to indicate all zero values on a worksheet as blank cells.  

Display or hide zero values on an entire worksheet  

1. Click the file button  

2. Select “Options” or “More” + “Options”   

  

  

3. Select “Advanced” category  

  

  

4. Under Display options for this worksheet,  

 

  

The zero value cells are now blank, but they still contain formulae.   

deselect the checkbox beside  

“ Show a zero in cells that have  

zero value ”   
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Autofill  

You can use the AutoFill option to enter a recognized sequence, such as January to 

December or Monday to Friday. To use the AutoFill option, enter the first element of the 

sequence, and then drag the fill handle, which is located at the lower-right corner of the 

cell, to fill all the selected cells with that sequence.   

You can use a similar tool called Fill Series to enter a data series. You need to enter the 

first two values in two cells and then use the fill handle to extend the series in the 

required cells.   

To enter a series starting at 2 and increasing by 2, type 2 in one cell and 4 in the next 

cell. Then, select both cells and use the fill handle to extend the series to the required 

number of cells.   

Insert a static date or time  

A static value in a worksheet is one that doesn’t change when the worksheet is 

recalculated or opened.   

  

When you press a key combination such as CTRL+; to insert the current date in a cell,   

  

Note: CTRL + ; means only press CTRL and semi-colon.  Do not press the + key.  

  

Excel “takes a snapshot” of the current date and then inserts the date in the cell. That 

cell’s value doesn’t change, so it’s considered static.  

Exercise:  

On a new worksheet tab (rename Time & Date), select the cell into which you want to 

insert the current date or time. Do one of the following:  

  

To insert the current date, press 

CTRL+; (semi-colon).  

  

To insert the current time, press 

CTRL+SHIFT  ; (semi-colon).  

  

To insert the current date and time, press CTRL+; (semi-colon),  

 

Then press the SPACE bar, and then press CTRL+SHIFT+; (semi-colon).  
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Insert a date or time whose value is updated:  

  

A date or time that updates when the worksheet is recalculated, or the workbook is 

opened is considered “dynamic” instead of static.   

  

In a worksheet, the most common way to return a dynamic date or time in a cell is by 

using a worksheet function.  

  

To insert the current date or time so that it is updatable, use the TODAY and NOW 

functions, as shown in the following example.  

  

Select the cell where the date and time is to be shown C6  

  

Select:   Autosum   More Functions   Date and Time   NOW   OK  

  

  

  

 

  

  

  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

=TODAY() 

=NOW() 

Note: Cell must 

be formatted to 

Time h:mm:ss  
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Perform Mathematical Calculations  

In Microsoft Excel, you can enter numbers and mathematical formulas into cells. 

Whether you enter a number or a formula, you can reference the cell when you perform 

mathematical calculations such as addition, subtraction, multiplication, or division. 

When entering a mathematical formula, precede the formula with an equal “=”  sign. 

Use the following to indicate the type of calculation you wish to perform:  

+ Addition    

- Subtraction   

* Multiplication  

/ Division  

In the following exercises, you practice some of the methods you can use to move 

around a worksheet, and you learn how to perform mathematical calculations. Refer to 

Lesson 1 to learn more about moving around a worksheet.  

Exercise: 

Open a new spreadsheet and rename the tab “Basic Calculations”  

Addition  

  

1. Type Add in cell A1.   
2. Press Enter. Excel moves down 

one cell.   
3. Type 1 in cell A2.   
4. Press Enter. Excel moves down 

one cell.   
5. Type 1 in cell A3.   
6. Press Enter. Excel moves down 

one cell.   
7. Type =A2+A3 in cell A4.   
8. Click the check mark on the 

Formula bar. Excel adds cell A1 to 

cell A2 and displays the result in 

cell A4. The formula displays on 

the Formula bar.   
 

 
Note: Clicking the check mark on the Formula bar is similar to pressing Enter. Excel records your entry but does not 

move to the next cell.  
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Subtraction  

1. Type Subtract in cell B1.   
2. Press Enter. Excel moves down one cell.  
3. Type 6 in cell B2.   
4. Press Enter. Excel moves down one cell.   
5. Type 3 in cell B3.   
6. Press Enter. Excel moves down one cell.   
7. Type =B2-B3 in cell B4.   
8. Click the check mark on the Formula bar. 

Excel subtracts cell B3 from cell B2 and the 

result displays in cell B4. The formula 

displays on the Formula bar.  

Multiplication  

1. Hold down the Ctrl key while you press "g" (Ctrl+g). The Go To dialog box appears.   
2. Type C1 in the Reference field.   
3. Press Enter. Excel moves to cell C1   
4. Type Multiply.   
5. Press Enter. Excel moves down one cell.   
6. Type 2 in cell C2.   
7. Press Enter. Excel moves down one cell.   
8. Type 3 in cell C3.   
9. Press Enter. Excel moves down one cell.   
10. Type =C2*C3 in cell C4.   
11. Click the check mark on the Formula bar. Excel multiplies C1 by cell C2 and displays 

the result in cell C3. The formula displays on the Formula bar.  

Division  

1. Press F5.   
2. Type D1 in the Reference field.   
3. Press Enter. Excel moves to cell D1.   
4. Type Divide.   
5. Press Enter. Excel moves down one cell.   
6. Type 6 in cell D2.   
7. Press Enter. Excel moves down one cell.   
8. Type 3 in cell D3.   
9. Press Enter. Excel moves down one cell.   
10. Type =D2/D3 in cell D4. 
11. Click the check mark on the Formula bar. Excel divides cell D2 by cell D3 and displays 

the result in cell D4. The formula displays on the Formula bar.   
 

ACTION: Save your work as your Surname Forename Excel 2 
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Excel - Workshop Inventory Exercise:  

Open Excel  

1. File - Save As – 'Surname First name Excel 3'.  

2. Highlight All cells (button at top left)  

3. Select '12' for font point size and 'Times New Roman' as font type  

4. Using mouse, highlight cell 'F1'  

5. Set font size to '18'  

6. Select 'Bold'  

7. Type 'Workshop Inventory'  

8. Note how the text overwrites the adjoining cells 'G1' & 'H1'  

9. Click on 'G1' and note how no content shows for this cell  

10. Click the File Tab, select 'Print' this shows you 

'Print Preview'. Now  click the back arrow to Close 

Print Preview.  Note how the page margins appear 

as dotted lines in the spreadsheet  

11. Change the orientation of the page to 'Landscape' on the 'Page Layout' tab.  

12. Drag the cursor over cells 'F1, G1, H1 and i1' to highlight them. 'Right-click' on 

the highlighted cells to display a 'drop-down' menu  

13. 'Click' on 'Format Cells'  

14. 'Click' the 'Border' tab  

15. Select 'top', 'bottom', 'left' and 'right' or 'Outline'  

16. 'Click' the 'Fill' tab.  

17. Select 'pale green' from colour chart  

18. 'Click' 'OK' button  

19. Highlight cell 'A4'  

20. Type 'Room No.'  

21. Use down arrow to highlight next cell beneath  

22. Type 1,2,3,4 & 5 in each cell range from 'A5' to 'A9' and 'Centre' the numbers  

23. Highlight 'C4', select 'Bold' and type 'Saws'  

24. Highlight 'D4', select 'Bold' and type 'Hammers'  

25. Highlight 'E4' select 'Bold' and type 'Chisels'  
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26. Highlight the three cells 'C4', 'D4' & 'E4'  

27. Select 'Centre' to centre the text  

28. In cell 'G4' type 'Unit Cost'   

29. To widen a column simply double click 

on the border at the top  

30. In cell 'H4' type 'Vat @ 21%'  

31. In cell 'i4' type 'Unit cost inc.' (This is 

the Unit cost including the VAT rate.   

32. In cell 'J4' type 'Total value'  

33. Fill in the numbers in cells 'C5' to 'E9' to represent inventory for each of the listed 

items.   

 

  

Formulas:  

  

Highlight cell 'C11' & Type:   =Sum(C5:C9)  Then press 'Enter'  

Highlight cell 'D12' & Type:   =Sum(D5:D9)  Then press 'Enter'  

Highlight cell 'E13' & type:    =Sum(E5:E9)  Then press 'Enter'  

The totals for the cells listed will be automatically calculated and placed in the cells 

containing the formulas.  

Fill in the unit cost for each item as follows – Saws Cell 'G11' is 42 , Hammers 'G12' is 

16 and Chisels 'G13' is 18  

In cell 'H11' type: '=G11*0.21'.  This formula will calculate the VAT @ 21%  

Highlight cell 'H11', 'right click' and select 'copy'  

Highlight cell 'H12', 'right click' and select 'paste'  

Highlight cell 'H13', 'right click' and select 'paste'  
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 In 'i11' type   =G11 + H11. Copy this formula to cells i12 and i13. Decide on a formula for 'J11', 

'J12' & 'J13' to show total value for each item.  

In 'J15' type a formula to represent the 'Grand Total'  

 

Highlight cells 'A4' to 'J4' and place a line beneath using 'Border' option.  

If you have not already worked it out you will now fill out the formula required to 

populate column J. Tip: The Total Value is the total number of each item (e.g. saws = 

71) multiplied by the Unit cost Inc  

  

 

 

 

 

 

 

 

 

 

 

  

Highlight cells  ' A4 '   to   ' J15 ' ,  

' R ight - click '   and select  ' Format  

C ells ' ,    

' Border '   

Select  ' Outline '   

  and    select this   

for internal    

column lines   

  

Click  ' OK '   
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Charts:  

  

Generate a chart to represent the number of tools per room:  

  

• Highlight cells 'C4 to E9'  

• On the Insert Tab in the Charts Group click Column and choose “3-D Clustered Column”  

• A column chart will be generated to reflect the number of saws, hammers and 

chisels in the respective rooms.  

• Edit the table title to read 'Tools per Room'   

  

Chart can be resized and placed as required on sheet.  

  

  
 

 

 

 

 

 

  

 

 

 

 

ACTION: Save your work as your Surname Forename Excel 3 

 



 

25  

  

Laying out an invoice Exercise:   

You are required to lay out a sales invoice (see next page). Open a new Excel file and 

name the spreadsheet tab “Invoice exercise 4”.  The invoice must contain:  

• Your company’s name, address, telephone number, Email address and/or 

Fax number.  

• The Title "Invoice"  

• The clients name and address  

• Invoice Number  

• Date and Time (insert using "Now" option in "Function" command).  

• Account number.  

• Column headings to include "Quantity", "Item", "Unit Value", "Net Value", 

“20% VAT” and "Gross".  

1. The invoice is to accept twenty lines of items. Note: Where formulae are copied 

down along columns and there are no entries in rows upon which calculations are 

to be performed the software may display Zeros. The cells in affected columns 

must be formatted to display nothing rather than zero values (page 16)  

2. The Quantity column, below its title, is to be formatted to centre alignment and 

integer numbering only (no fractions and zero decimal places).  

3. The "Item" column should be wide enough to accept reasonable descriptive detail.  

4. The "Unit Value" column, below its heading, should be set to accept Numeric data 

only and set to Two places of decimal.  

5. The "Net Value" column should calculate the product of the "Quantity" column 

multiplied by the "Unit Value" column for each entry.  

6. The “20% VAT” column should contain a formula to calculate 20% of that 

contained in the "Net Value" column for each entry.  

7. The "Gross" column should automatically calculate the total value of VAT and 

NET Value.  

8. Totals for "Net Value", "Vat" and "Gross" columns should automatically update as 

data is changed in the relevant cells.  These Column total cells should be set to 

display the "€" sign.  

The bottom of the invoice should have space given to two entries:  

 Issued By:  

 Received By:  
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ACTION: Save your work as your Surname Forename Excel 4 

Now email a copy of all  files to me Robert.hickey@tudublin.ie  

mailto:Robert.hickey@tudublin.ie

